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1. ЧТО ТАКОЕ INTERNET

Сегодня о сети Internet говорят все, однако большинство людей на самом 
деле не имеют о ней четкого представления. Одной из причин такого положе­
ния дел можно считать то, что пользователи представляют себе сеть Internet 
совершенно по-разному, в зависимости от того, каким образом они с нею по­
знакомились и для чего она им нужна. Другая причина состоит в том, что все 
говорят об Internet, как будто она действительно является сетью. Однако факт 
остается фактом: Internet - не просто сеть, это понятие намного шире. В сущ­
ности, Internet представляет собой способ объединения компьютеров.

Если компьютер или какая-либо небольшая сеть может "говорить" с дру­
гими машинами на языке Internet (или, выражаясь техническим языком, под­
ключайся с применением протоколов), то этот компьютер считается включен­
ным в сеть Internet. И если представить Internet в виде какого-либо языка об­
щения людей, то это будет не французский и не фарси, не русский и не анг­
лийский - это будет язык эсперанто.

Электронная почта и многое другое

Сеть Internet, кроме всего прочего, представляет собой своеобразное соб­
рание разных способов связи и хранения информации в форме, которая обес­
печивает возможность доступа к этой информации. Рассмотрим, например, 
электронную почту. Если вы работаете в офисе, оборудованном локальной се­
тью, то у вас есть возможность иметь электронный адрес, связываться с дру­
гими пользователями своего офиса и отправлять им сообщения. Но это еще не 
Internet. Точно также, если вы имеете учетную запись (account) в диалоговой 
службе America Online и отправляете сообщение другому пользователю, заре­
гистрированному в этой же системе, вы еще не являетесь пользователем 
Internet. Однако, если сеть на вашей работе оборудована машиной-шлюзом для 
выхода в Internet и вы отправляете по электронной почте сообщение кому- 
либо за пределы своего офиса, то в этом случае вы связываетесь с ним именно 
по Internet (рис. 1.1).

Шлюз (gateway) - это компьютер либо работающая на нем программа, 
служащая для передачи файлов (или электронных сообщений) из одной сети в 
другую.

Однако Internet - это не просто объединение сетей, взаимосвязанных друг 
с другом. Через подключение к какой-либо сети или провайдеру, соединенно­
му с Internet, получить доступ к Internet может также и отдельный компьютер.

Предположим, вы работаете в локальной сети вашей организации и под­
ключаетесь к какой-либо группе новостей. Поначалу вам может быть непонят­
но, приходят ли сообщения в эту группу только из локальной сети организа­
ции или же она является группой новостей Internet. Одним из достоинств 
служб Internet является цельность, придающая всем имеющимся в вашем рас­
поряжении средствам вид частей одной и той же небольшой программы, рабо­
тающей на вашем компьютере.
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Рис. 1.1. Internet переносит электронные сообщения из одной сети в другую

И хотя упомянутые мною выше локальные сети и крупные коммерческие 
диалоговые службы сами по себе не являются сетью Internet, они могут обес­
печить (и часто обеспечивают) пользователям доступ к Internet через свои ма­
шины-шлюзы.

Web - это Internet или нет?

Львиная доля любой рекламы Internet в наше время посвящена восхвале­
нию World Wide Web. Эта сеть существует уже почти десять лет, и большую 
часть этого времени она была наиболее быстро развивающейся и самой попу­
лярной структурой Internet (за исключением разве что широкомасштабного 
распространения по всему земному шару электронной почты). В техническом 
смысле Web представляет собой всего лишь часть Internet, однако это действи­
тельно значительная ее часть, поскольку в те области Internet, которые, строго 
говоря, не являются компонентами Web, все же можно получить доступ с по­
мощью броузера Web.

Для Internet безразлично, каким компьютером вы пользуетесь

Одним из действительно приятных качеств Internet является то, что неко­
торые, кажущиеся нам весьма серьезными, различия разных видов компьюте­
ров для нее не имеют особого значения. Конечно, если вы работаете на 
Macintosh, вам необходимо иметь программное обеспечение именно для этой 
машины, а работая в Windows 95 - соответствующую программу, однако ин­
формация, полученная из Internet, из групп новостей или из World Wide Web 
будет выглядеть и работать практически одинаково, независимо от того, какой 
машиной вы пользуетесь.

Сегодня, когда определенные типы программ и услуг создаются для ра­
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боты в Web, а не на компьютерах какого-либо конкретного вида, Web быстро 
приобретает черты универсальной компьютерной платформы.

Еще одной привлекательной чертой Internet является то, что большая 
часть значительной нагрузки по обработке данных, а также по хранению очень 
больших программ и объемной информации ложится не на ваш компьютер. 
Ваша же машина - PC, Macintosh или рабочая станция Unix - становится про­
сто удобным средством для восхождения на высоты Internet. Клиенту надо 
только подключиться к серверу - и все красоты мира падают к его ногам, ему 
даже не приходится перезагружать свою машину. Именно этот факт и является 
основной причиной того, почему для работы в Internet практически безразлич­
но, какой компьютер вы предпочли.

Серверы представляют собой централизованные информационные архи­
вы или специализированные устройства для управления определенными вида­
ми информации.

Хотите знать, что можно делать в Internet?

После того, как вы начнете исследовать Web, вам может показаться утоми­
тельной плохая организация этой сети (только представьте себе библиотеку, в 
которой к каждой полке в качестве внештатного библиотекаря приставлен один 
из читателей, имеющих членский билет этой библиотеки, и каждый из этих 
микробиблиотекарей пользуется своей собственной системой расстановки книг 
на своем участке), а также то, что вы не знаете точно, где можно найти в Internet 
нужную вам информацию. К счастью, в Internet существует множество полез­
ных поисковых служб (search engine). Они, конечно, не очень похожи на биб­
лиотечные каталоги, но способны значительно облегчить вашу жизнь.

Поисковыми службами называются программы или Web-страницы, по­
зволяющие осуществлять поиск на узле Internet (или во всей сети) на основе 
специальных ключевых слов.

Web в наше время становится все более и более замечательным средст­
вом общения, со всеми "примочками", которые мы обычно ожидаем увидеть в 
телевизионной рекламе или в кинофильме, на съемку которого были потраче­
ны большие средства. Однако для того, чтобы в полной мере насладиться наи­
более динамичными средствами этой сети, вам необходимо научиться под­
ключать к своему броузеру специальные инструменты.

Если вы являетесь приверженцем идеи "живого" общения с людьми, а не 
размещения сообщений в Web и ожидания на них ответа, то вам, вероятно, захо­
чется узнать о различных средствах интерактивного общения в Internet, и в пер­
вую очередь - об IRC (Internet Relay Chat - трансляция разговоров по Internet).

Если вы не боитесь "черной работы" и намерены приступить к рытью тунне­
ля через Internet, подключаясь к компьютерам, находящимся в разных местах зем­
ного шара, и перемещая туда-сюда множество файлов, вы сможете сделать это с 
помощью своего Web-броузера. А может, у вас возникло желание проникнуть в 
сущность FTP (File Transfer Protocol - протокол передачи файлов) и Telnet - сис­
тем, позволяющих через Internet подключаться к удаленным компьютерам?

И, наконец, если вам захочется пополнить ряды пользователей Internet, имею­
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щих личные Web-страницы, можете разработать свой "шедевр", прославляющий вас 
на всю сеть Internet, или опубликовать список своих любимых узлов Internet.

Несколько слов об адресах Internet

Для тех, кто только начинает пользоваться Internet, одним из наиболее 
непонятных ее качеств является то, что слово "адрес" применяется для обозна­
чения трех разных понятий. Основное понятие, которое, однако, используется 
реже других - означает собой имя компьютера Internet, который также назы­
вают узлом (host или site), представленное в следующей форме: не­
что.нечто.нечто. (Если вы хотите правильно пользоваться языком Internet, при 
произнесении адреса следует произносить слово "точка", вы скоро привыкнете 
к этому, и это сэкономит вам немало времени). Например, адрес электронного 
журнала имеет следующий вид:

ezone.org.
Читая этот адрес справа налево, вы сначала получаете информацию о до­

мене, (org), что означает некоммерческую организацию. Далее иногда следует 
указание субдомена и, наконец - имени узла (в данном примере - ezone), кото­
рое является именем конкретного компьютера, в котором хранится названный 
выше журнал.

Другой вид адресов Internet - адреса электронной почты. Такие адреса со­
стоят из пользовательского имени (его также называют регистрационным 
именем, идентификатором пользователя, именем учетной записи и т.д.), за ко­
торым следует символ @, а затем - описанный выше адрес Internet. Предпо­
ложим, например, что вы хотите послать электронное сообщение редактору 
журнала Enterzone. В этом случае вы можете адресовать свое сообщение на 
специальное пользовательское имя, созданное для этой должности (по- 
английски - editor), которое останется неизменным, даже если эту должность 
займет в будущем кто-то другой:

editor@ezone.org
Адреса третьего вида встречаются сегодня на каждом шагу: на рекламных 

щитах, в телевизионной рекламе, газетах и так далее. Это адреса Web, которые 
также называют URL (Uniform Resource Locator - унифицированные локаторы 
ресурсов). Web-адрес журнала, о котором мы только что говорили, следующий: 

http://ezone.org/ez
К счастью, зачастую можно избежать ввода Web-адресов вручную, вы 

можете найти нужный адрес в Web с помощью щелчка на заранее определен­
ных гиперссылках. Гиперссылки представлены в документах Web в виде вы­
деленных слов или изображений, щелчок на которых приводит к открытию 
соответствующего нового документа, переходу в другую часть текущего до­
кумента или даже в файл совершенно другого типа.

Что такое World Wide Web

Одним из новейших средств Internet является World Wide Web. Web (ино­
гда ее называют WWW, W3 или W3) - это огромное собрание взаимосвязан­
ных гипертекстовых документов. Гипертекстовые документы могут содержать 
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в себе ссылки на другие документы, на файлы совершенно другого типа и на 
другие элементы Internet. С помощью Web-броузеров можно переходить от 
документа к документу, щелкая на интересующих вас гиперссылках. В на­
стоящее время World Wide Web еще не содержит всей информации, доступной 
через Internet, но интеграция ресурсов Web с остальными ресурсами Internet 
развивается очень быстро.

Прелесть Web состоит в том, что программы просмотра ее ресурсов, на­
зываемые броузерами (browser) или обозревателями, очень просты в употреб­
лении, что дает вам доступ ко всем видам данных, программ, новостей, графи­
ческих изображений и т.д. без изучения синтаксиса сложных протоколов и за­
гадочных команд Unix.

Гипертекст (hypertext) Web - это текстовый документ, в котором имеются так 
называемые гиперссылки (hyperlink), т.е. активные элементы, при щелчке на кото­
рых открывается другой документ или другая часть текущего документа.

Каждый раз, обращаясь к справке по какой-нибудь программе Windows, 
вы открываете гипертекстовый документ с определениями и ссылками, позво­
ляющими переходить к просмотру соответствующих тем с помощью щелчка 
мышью. Кроме перехода к другому документу гиперссылки могут представ­
лять собой средство обращения к серверам Gopher, FTP и Telnet, группам но­
востей Usenet и другим ресурсам Internet. Кроме того, с помощью гиперссылок 
можно запускать программы, открывать фафические изображения, воспроиз­
водить аудио- и видеоинформацию и т.д. После того как в документы кроме 
простого текста стали включаться и другие данные, вместо слова "гипертекст" 
начали применять слово гипермедиа (hypermedia). Однако суть от этого не из­
менилась - в основе документов гипермедиа лежат все те же гиперссылки. Та­
ким образом, гипертекст или гипермедиа, — это универсальное средство про­
смотра ряда взаимосвязанных документов любого вида с помощью механизма 
гиперссылок. Однако пока он имеет и недостаток: в большинстве случаев 
пользователь Офаничен только гиперссылками, созданными другими людьми. 
По этой причине гипертекст еще не является в полном смыслеслова интерак­
тивным средством. (Конечно, вы всегда можете создать собственную Web- 
страницу. Кроме того, гиперссылка может привести вас не только к гипертек­
стовому, но и к обычному текстовому документу. Из такого документа вы не 
сможете перейти дальше, так что процесс в определенном смысле зайдет в ту­
пик, но зато всегда можно повернуть назад.)

Новые свойства Web

Все больше и больше современных профамм предоставляют пользовате­
лю возможность осуществлять поиск в Web и выводить документ на экран в 
формате Web (HTML). Конкуренция среди Web-броузеров очень велика 
Netscape и Microsoft напряженно борются за доминирующее положение на 
рынке этого профаммного обеспечения. (Еще одним популярным броузером 
является Apple Cyberdog, однако его применение офаничено компьютерами 
Macintosh). Каждый жизнеспособный броузер, кроме всего прочего, включает 
в себя почтовый модуль и модуль новостей. В последнее время наметилась 
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также тенденция включать в броузеры средства редактирования Web-страниц. 
Следующие версии популярных броузеров будут объединять интерфейс Web с 
рабочим столом вашего компьютера. Наконец, локальные сети предприятий 
все больше и больше "обрастают" средствами, характерными для Internet. При 
работе в таких сетях, получивших название "интрасети" (intranet), у пользова­
теля, обращающегося к ресурсам локальной сети, возникает ощущение, будто ;• 
он работает в Internet, хотя на самом деле в этот момент его броузер может < 
просматривать Web-страницы, находящиеся на диске компьютера сидящего 
рядом с ним коллеги.

Таковы изменения в мире инструментов. Несмотря на то, что подтвер­
жденной жизнью модели получения гарантированной прибыли с помощью 
Web пока не существует, в Web, как грибы, возникают новые коммерческие 
узлы. Появился новый смелый метод доставки содержимого через Web, кото­
рый называется "сетевым вещанием" (netcasting). Он позволяет просматривать 
ресурсы Web в автономном режиме в удобное для вас время.

2. РАБОТА С БРОУЗЕРАМИ INTERNET

Адреса Web (URL)

Если вы когда-нибудь видели рекламные объявления, гласящие: "Посети­
те наш узел Web", вы, должно быть, припоминаете какие-то загадочные буквы, 
называемые в таких объявлениях адресами, или URL (URL - это аббревиатура 
Uniform Resource Locator, то есть унифицированный локатор ресурсов). Адре­
са почти всегда начинаются с букв http:. Web-адрес начинается с имени прото­
кола (метода подключения к источнику информации), и в большинстве случа­
ев таким протоколом является протокол HTTP. HTTP - это аббревиатура от 
английского Hypertext Transfer Protocol, то есть протокол передачи гипертек­
ста. Он означает, что данный ресурс можно найти на Web-сервере. За указани­
ем протокола следует :// (произносится как "двоеточие-две косых"), а затем - 
адрес Internet в форме узел.субдомен.домен. После этого иногда идет двоето­
чие и номер порта (что бывает, однако, довольно редко), а затем - ведущий к 
данному ресурсу путь с перечислением имен папок или каталогов, также отде­
ленных друг от друга косыми. Далее может быть указано имя файла, которое в 
большинстве случаев заканчивается расширением .htm или .html. Такое рас­
ширение присваивается файлам в формате HTML, которые являются самыми 
распространенными документами в Web. К счастью, чаще всего вам не при­
дется вводить адреса Web вручную, поскольку для этого можно воспользо­
ваться гиперссылками, в которых содержатся URL.

Не приходите в отчаянье при виде жуткой мешанины аббревиатур, с ко­
торой вы сталкиваетесь, начав путешествовать по Web. Как я уже говорил вы­
ше, URL означает просто заумное название адреса, который могут распозна­
вать Web-броузеры. URL всегда имеют следующую форму:

прото кол://узел : порт/каталог/файп
Таким образом, URL gopher://gopher.hike.te.chiba-u.ac.jp:70/l 1/arvive/net- 

legends-fac дает броузеру указание: "Использовать протокол Gopher для под­
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ключения к узловому компьютеру, носящему название gopher.hyke. te.chiba- 
u.ac.jp (т.е. компьютер находится в Японии (jp), подключен к сети академиче­
ских учебных заведений (ас) через сеть университета Чиба (chiba-u), в котором 
ему присвоено имя gopher.hyke.te), подключиться к порту 70, просмотреть 
папку 11/archive/ И найти файл С именем net-legends-faq." Протокол, который 
обычно применяется для подключения к гипертекстовым документам, называ­
ется HTTP, т.е. протоколом передачи гипертекста, поскольку броузеры поль­
зуются им для просмотра гипертекстовых документов. Если вами затребован 
этот протокол, URL будет начинаться с http: (другие протоколы - это ftp:, 
telnet: и т.д. Существует также протокол, начинающийся с file:. Он является 
эквивалентом ftp:).

Еще одним, возможно, непонятным для вас сокращением, с которым при­
ходится сталкиваться в ходе работы с Web, является HTML (Hypertext Markup 
Language - язык разметки гипертекста). HTML - это специальный язык про­
граммирования, применяемый для создания гиперссылок в текстовых докумен­
тах с тем, чтобы сделать их гипертекстовыми документами. Гипертекстовые до­
кументы в Web, как правило, заканчиваются расширением .htm или .html.

Основные принципы работы броузеров

Как правило, запустив программу броузер Web, вы открываете основную 
Web-страницу (home page), т.е. исходное место, с которого вы предпочитаете 
начинать сеансы путешествия в Web. В качестве основной можно использо­
вать Web-страницу, установленную броузером пр умолчанию, либо указать 
нужную вам Web-страницу. Некоторые броузеры также могут быть запущены 
при щелчке на Web-адресе в другой программе. Сегодня существуют про­
граммы электронной почты, например, Outlook Express, которые позволяют 
дважды щелкнуть на URL в сообщении электронной почты, чтобы автомати­
чески запустить броузер и открыть соответствующую Web-страницу.

Так как развитие Internet и, в частности, World Wide Web идет хаотически и де­
централизовано, начинающие пользователи часто оказываются сбитыми с толку раз­
личными терминами, применяющимися для названия одних и тех же понятий, или, 
наоборот, одинаковыми терминами, применяемыми в разных программах для обозна­
чения разных понятий. В частности, это касается терминов, относящихся к Web- 
страницам - в разных программах можно встретить такие названия, как основная, 
стартовая, домашняя, главная, начальная и т.п. Мы будем называть основной страни­
цей (home page) Web-страницу, которая открывается по умолчанию при запуске бро­
узера. Начальная страница (start page) - это Web-страница, посвященная какой-либо 
теме на Web-узле компании. Одна из начальных страниц Web-узла является главной 
(main page) - переходя по ссылкам, содержащимся на такой странице, можно добрать­
ся до любого документа, содержащегося на том или ином узле. Таким образом, поль­
зователь может выбрать в качестве основой страницы любую главную, начальную 
или обычную Web-страницу какой-либо компании, если он хочет, чтобы каждый се­
анс работы в Web начинался с просмотра именно этой страницы.

Диалоговые службы предлагают пользователям два способа доступа к Web: 
либо с применением встроенных лицензированных броузеров (обычно Microsoft 
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Internet Explorer), либо с помощью внешнего броузера в совокупности с главной 
программой доступа. Провайдеры Internet также позволяют запускать любой по­
нравившийся вам броузер через удаленный доступ (большинство пользователей 
выбирают для этого Internet Explorer или Netscape).

Популярность Web растет с каждым днем, и вы можете столкнуться с за­
держками при подключении к новым адресам. Если при переходе по какой-то ги­
перссылке документ долго не открывается или после длительного ожидания поя­
вилось сообщение об ошибке, попробуйте еще раз открыть документ, сначала сра­
зу после сбоя, а затем - в непиковое время (поздно вечером или в выходные).

Открыв Web-страницу, можно выполнять следующие операции:
• Просматривать интересующие вас документы с помощью гиперссылок. В 
любой момент можно свернуть совершенно в другую сторону от развития те­
мы или просмотреть список всех документов, которые вы просматривали в хо­
де данного сеанса, а затем сразу перейти к одному из таких документов.
• Переходить к конкретному Web-адресу (URL). Как правило, для того, чтобы 
после запуска броузера не дожидаться окончания загрузки основной страницы, 
надо нажать кнопку Stop и ввести необходимый адрес.
• Вставлять закладки, которые дадут вам возможность возвращаться к интере­
сующей вас странице, избавляя от необходимости вновь повторять в обратном 
порядке все пройденные этапы или просматривать весь журнал.
• Получать или пересылать по почте интересующие вас документы и файлы.
• Просматривать скрытый URL (Web-адрес), на который указывает данная ги­
перссылка.
• Назначать в качестве основной любую интересующую вас Web-страницу, 
чтобы при каждом запуске броузера сразу можно было увидеть нужную вам 
информацию без дополнительных переходов по гиперссылкам.
• С помощью соответствующей команды или меню получать доступ к спра­
вочной системе, чтобы ознакамливаться с методами использования данной 
программы и информацией о самой Web.
• Находить информацию о новостях Internet.

Чтение страницы с помощью броузера

Web-страницы могут содержать форматированный текст и заголовки, иллюстра­
ции, фон и цветовые эффекты, а также гиперссылки, которые могут быть представле­
ны с помощью выделенного тем или иным образом текста или с помощью изображе­
ний. В большинстве графических броузеров гиперссылки выделены голубым цветом 
(если только автор страницы не назначил другой цвет) и подчеркиванием (если, опять 
же, автор не назначил другой цвет и не изменил параметры настройки программы).

Довольно часто Web-страница может не помешаться на экране. Анало­
гично другим программам, в графических броузерах для просмотра материала, 
выходящего за пределы экрана, используются полосы прокрутки. Если вам не­
обходима конкретная часть информации, находящаяся на длинной странице 
документа, попробуйте найти ключевое слово. Как правило, это можно сде­
лать с помощью соответствующей команды меню.

Если открытие страницы, особенно содержащей много графики, идет 
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слишком медленно, либо если у вашего броузера возникают проблемы при за­
грузке некоторых видов художественного оформления или каких-либо Web- 
страниц, советую подумать об отключении функции автоматической загрузки 
графических изображений, для чего большинство броузеров имеют специаль­
ную команду. В этом случае вы сохраните возможность загружать, при необ­
ходимости, любые картинки, которые хотели бы уввдеть, и даже видеть все 
художественное оформление страницы одновременно, но процесс просмотра 
будет происходить намного быстрее.

Переход по гиперссылкам

В графических броузерах для перехода по гиперссылке необходимо поместить 
на нее указатель мыши (указатель при этом изменяется для индикации того, что вы 
находитесь в области активной гиперссылки, - в Internet Explorer и Netscape вместо 
стрелки появляется пиктограмма с изображением руки) и щелкнуть на ней один раз 
(советую как можно скорее избавиться от привычки щелкать дважды).

Все броузеры имеют команду Back (Назад), часто в виде панели инстру­
ментов, с помощью которой вы можете возвратиться на предыдущую страни­
цу. Вернувшись назад, вы можете также пойти снова вперед, воспользовав­
шись для этого командой Forward (Вперед), и возвратиться по пройденному 
ранее маршруту к самому последнему пункту, которого вы до этого достигли.

Кроме того, можно вывести на экран список всех Web-страниц, на кото­
рых вы побывали с момента начала данного сеанса работы (в графическом 
броузере он будет иметь вид меню, в текстовом броузере такой список откры­
вается на отдельной странице).

В списках просмотренных страниц многих броузеров регистрируются 
только те страницы, которые вы посетили по "прямой линии" от исходной 
точки. Если вы возвращались назад или переходили к другой гиперссылке, то 
утратите все этапы, пройденные вами до гиперссылки, к которой вернулись. 
Так, например, если вы прошли этапы А, В, С и D, а затем вернулись к В и пе­
решли к Е, то в списке могут отображаться только этапы А, В и Е.

Как узнать, куда переходить

Поскольку реальной точки отсчета в Web не существует, ориентироваться 
в ней довольно сложно. Хотя начальная страница по умолчанию должна пре­
доставлять пользователю довольно удобные исходные точки, советую вам 
сначала немного попутешествовать по Web и проверить, куда вы сможете из 
этих точек добраться.

В большинстве броузеров, если у вас есть конкретный Web-адрес (напри­
мер, адрес, который вы видели в рекламном объявлении, или который был при­
слан вам по электронной почте), то для того, чтобы попасть в нужную Web- 
страницу, не проходя по всем ведущим к ней гиперссылкам, вы можете ввести 
известный вам URL. (Кстати, URL произносится как "у-эр-эл".) Кроме того, вы в 
любой момент можете перейти к основной странице. В графических броузерах 
для этой цели имеется кнопка Ноте (Домой), часто с изображением домика.
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Щелкните на графической схеме

Одним из наиболее распространенных средств перемещения по узлам 
Web является графическая схема узла (image map). Такая схема представляет 
собой изображение или набор изображений, при щелчке на которых броузер 
переходит к другим Web-страницам. Web-узлы с хорошо проработанным ин­
терфейсом зачастую содержат две основные схемы: первая имеет вид "шапки" 
в верхней части начальной страницы узла, и функции ее активизируются с по- 
мбщью щелчка на одном из элементов; вторая представляет собой маленькое 
меню, расположенное внизу каждой другой страницы.

Работа с кадрами

Все чаще и чаще вам будут встречаться страницы, поделенные на кадры 
(frames) - специальные области, содержимое которых изменяется независимо 
друг от друга. (Хотя кадры на Web-страницах используются уже сравнительно 
давно, администраторы большинства узлов, по крайней мере на начальных 
страницах, воздерживаются от создания кадров. Это связано с нежеланием от­
талкивать от своего узла пользователей, броузеры которых не поддерживают 
кадров, не говоря уже о том, что многие люди вообще считают их слишком 
громоздкими и отвлекающими внимание).

Наиболее распространенными видами кадров являются кадр для пере­
движения по Web-узлу и кадр просмотра содержимого. Иногда кадры исполь­
зуются для вывода на экран рекламных объявлений по мере того, как пользо­
ватель переходит от страницы к странице узла Web.

Вспомогательные окна

Еще одним нововведением в интерфейсе Web является использование до­
полнительных плавающих окон. Хотя многие броузеры позволяют щелкнуть 
правой кнопкой мыши (или, в Macintosh, щелкнуть и удерживать эту клавишу в 
нажатом состоянии) на гиперссылке, в результате чего на экране появляется ме­
ню, с помощью той или иной команды которого можно открыть соответствую­
щую страницу в новом окне, разработчики Web создали также гиперссылки, по­
зволяющие автоматически открывать новое окно. Некоторые узлы также выво­
дят на экран маленькое окно без меню, которое может использоваться в качестве 
панели управления. Иногда это может привести к некоторой путанице, напри­
мер, когда вы длительное время путешествуете по Web и в конце сеанса на ва­
шем экране оказываются открытыми несколько дополнительных окон.

Не забывайте закрывать вспомогательные окна сразу после того, как вы 
ими воспользовались, а также выясните, какой метод переключения окон под­
ходит вам лучше других (в Windows вы можете переключаться с помощью 
щелчков, нажатием комбинации клавиш Alt+Tab или посредством выбора со­
ответствующей команды в меню). Запомните, что если вы немного запутались 
и не знаете, как попали в окно, в котором на данный момент находитесь, все­
гда можно воспользоваться кнопкой Back (Назад).
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Microsoft Internet Explorer

Internet Explorer - это не только броузер диалоговой службы Microsoft 
Network. Можно сказать, что эта программа является исключением среди бро­
узеров, поскольку она может работать с любыми подключениями к Internet. 
Существуют версии Internet Explorer как для Windows, так и для Macintosh, 
однако в Windows эта программа применяется намного шире.

Internet Explorer имеет кнопки Васк (Назад) и Forward (Вперед). (В версии 
4.0 с помощью щелчка правой клавишей мыши на этих кнопках вы можете 
увидеть десять своих последних перемещений в любом направлении). Вы мо­
жете вернуться в любой из недавно пройденных вами узлов, открыв меню File 
(Файл) и выбрав нужную страницу из списка, расположенного рядом с кноп­
кой этого меню (сразу над командой Exit (Выход). Когда вы начинаете вводить 
URL, в Microsoft Explorer 4.0 автоматически предлагается ряд URL, введенных 
вами до этого и до какого-то момента совпадающих с вводимым вами в дан­
ный момент адресом. Если адрес совпал полностью, надо просто нажать кла­
вишу Enter и принять подсказку. В противном случае продолжайте ввод URL 
самостоятельно.

Щелкнув на кнопке раскрытия списка адресов, можно выбрать любой ад­
рес из тех, которые вы когда-либо вводили. Чтобы вернуться к основной стра­
нице, щелкните на кнопке Ноте (Домой).

Ссылки на наиболее интересные, на ваш взгляд, страницы можно сохра­
нить, выбрав команду Favorites>Add to Favorites (Избранное»Добавить в "Из­
бранное") Добавляемая страница в тот же момент станет элементом меню из­
бранных страниц. Чтобы перейти к какой-либо странице, занесенной в список 
избранных, вам надо просто выбрать элемент из этого меню.

Чтобы сохранить в Internet Explorer какой-либо документ Web, выберите 
команду File>Save As (Файл>Сохранить как). Кроме того, вы можете сохра­
нить и ярлык ресурса, - небольшой файл, содержащий Web-адрес, - выбрав 
для этого команду File>Create Shortcut (Файл>Создать ярлык). Чтобы отпра­
вить такой файл какому-либо другому пользователю, выберите команду 
File>Send>Shortcut (Файл>Отправить>Ссылку на нее по почте), в результате 
чего на экране появится окно создания нового сообщения электронной почты с 
уже вложенным в сообщение ярлыком.

Чтобы просмотреть исходный текст документа Web, выберите команду 
View>Source (Вид>В виде HTML). Изменение основной страницы также пред­
ставляет собой несложный процесс.
1. Первым делом перейдите на Web-страницу, которую вы хотели бы исполь­
зовать в качестве основной.
2. Выберите команду View>Options (Вид>Свойства обозревателя) и щелкните 
на вкладке General (Общие) появившегося в результате этого действия диало­
гового окна.
3. Щелкните на кнопке Current (С текущей).
4. И, наконец, щелкните на кнопке ОК.

Чтобы получить доступ к справочной информации в Internet Explorer, вы­
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берите команду Help>Help Topics (Справка-Содержание и предметный указа­
тель). Кроме того, в меню Help (Справка) имеется ряд команд, с помощью ко­
торых можно найти множество интересной информации о Web.

Netscape

Netscape Navigator (как правило, эту программу называют просто Netscape) 
является одним из самых распространенных Web-броузеров, уступая пальму пер­
венства лишь Internet Explorer, который продолжает отвоевывать тот огромный 
рынок сбыта, который некогда принадлежал исключительно Netscape. Последняя 
версия Netscape, Netscape Communicator, стала настоящим бестселлером. Та часть 
программы, которая представляет собой броузер, до сих пор носит название 
Netscape Navigator (так же, как и несколько последних версий).

Запуск Netscape осуществляется двойным щелчком на пиктограмме 
Netscape (либо выбором команды Netscape Navigator 4.0 из меню Start (Пуск)), 
в результате чего на экране появляется начальная страница Netscape.

Для перемещения со страницы на страницу воспользуйтесь кнопками 
Back и Forward. С помощью меню Go вы сможете увидеть перечень страниц, 
на которых побывали в ходе текущего сеанса работы. Чтобы перейти на кон­
кретную Web-страницу, введите ее адрес в строке Location, которая, как толь­
ко вы начнете набирать адрес, сменится строкой Go То. По мере ввода URL 
Netscape постарается закончить его автоматически. Если предложение про­
граммы соответствует тому, что вы собирались ввести (и вы это заметили), 
нажмите клавишу Enter, в противном случае продолжайте ввод. Вы также мо­
жете открыть раскрывающийся список, в котором перечисляются все введен­
ные вами когда-либо адреса.

Чтобы сделать в Netscape закладку, щелкните на кнопке Bookmarks и вы­
берите Add Bookmarks. Если вам надо перейти к какой-либо закладке, выведи­
те меню Bookmarks и выберите из него нужный элемент.

Для сохранения в Netscape документа Web, выберите команду File>Save 
As. Чтобы отправить по почте документ какому-либо другому пользователю, 
воспользуйтесь командой File>Mail Document. Для управления способом от­
правки документа (в виде документа HTML (по умолчанию) или в виде про­
стого текста), щелкните на кнопке Attachment.

Если вы хотите увидеть исходный текст HTML Web-страницы, выберите 
команду View>Source. Чтобы изменить в Netscape основную страницу, первым 
делом скопируйте URL страницы, которым хотите воспользоваться. После 
этого выберите команду Edit>Preferences>General Preferences и щелкните на 
вкладке Appearance. Введите или вставьте Web-адрес в строке Browser Starts 
With, расположенном в группе Startup, и щелкните на кнопке ОК.

В любой момент, когда вам понадобится справка о Netscape, можете вос­
пользоваться командой Help>Help Contents (либо любой другой командой из 
меню Help). Просмотреть, что изменилось в Internet за последнее время, мож­
но, щелкнув на кнопке Places и выбрав пункт What's New? What's Cool?, либо 
какой-нибудь другой.
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Поиск в Internet

Как только вам представился шанс хоть немного попутешествовать по 
Web, у вас, вполне вероятно, сразу возник вопрос, каким способом в ней мож­
но найти нужную информацию. Как бы ни было просто переходить со страни­
цы на страницу и наугад бродить от одного интересного узла к другому, таким 
способом вы не сможете определить ясного и прямого пути и найти в Web 
конкретного адресата, если вам не известен его точный Web-адрес.

На наше счастье, нашлись умные люди и компании, которые создали в сети 
узлы, помогающие находить в Web разную информацию. Хотя единого и опре­
деленного места, из которого можно было бы осуществлять поиск, не существу­
ет, зато в нашем распоряжении имеется ряд поисковых служб (и время от вре­
мени появляются все новые). Кроме того, Internet изменяется настолько быстро, 
что любой централизованный список узлов для некоторых методов непременно 
будет устаревшим, едва появившись. И все же процесс "схематизации" Internet 
продолжается непрерывно, и уже на нынешнем этапе разработаны средства, 
вполне способные помочь вам найти в Internet то, что вы ищете. Поскольку еди­
ного и определенного способа поиска в Web не существует, самым лучшим под­
ходом зачастую является применение нескольких разных методов.

Новинки в области поиска информации

В последнее время каталоги Web и ее поисковые службы приобретают 
все больше и больше общих черт. Существует еще одна новая тенденция: а 
именно то, что постоянно и повсеместно возникают универсальные поисковые 
Web-узлы, которые содержат ссылки или разделы, с помощью которых можно 
использовать самые популярные каталоги и поисковые службы Web. Широкое 
распространение интрасетей вызвало потребность в создании поисковых 
служб, с помощью которых пользователи могли бы находить ресурсы, распо­
ложенные в локальной сети предприятия.

Если вы являетесь пользователем MS Internet Explorer 4.0 или Netscape 
Navigator 4.0, то можете вводить термины непосредственно в адресной строке 
и получать перечни ссылок на соответствующие Web-страницы с помощью 
используемой по умолчанию поисковой службы. Можете быть абсолютно уве­
рены, что по мере того, как Internet продолжает расти в геометрической про­
грессии и ее структура становится все более сложной (хотя она уже и так дос­
таточно запутана и хаотична), на рынке программного обеспечения будут по­
являться новые, все более и более сложные средства поиска, помогающие с 
точным попаданием находить нужную вам информацию и ресурсы.

Поиск в Web

В Web имеется ряд узлов, предлагающих пользователю одну из двух моде­
лей поиска конкретной информации. Суть первой модели состоит в использова­
нии так называемых каталогов (directory) - узлов Web, содержащих ссылки на 
различные ресурсы Web, организованные по темам, как это обычно делается в 
справочниках типа Желтые страницы (Yellow Pages). Вторая модель заключается 
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в обращении к специальным поисковым службам (search engine). В этом случае вы 
вводите ключевое слово для поиска, после чего поисковая служба выдает вам спи­
сок названий узлов, которые она сочла совпадающими с темой вашего поиска. 
Ниже будут приведены примеры применения каждого из этих методов.

Поиск в каталогах

Одним из лучших каталогов Web является узел Yahoo. Вы можете увидеть 
его, введя в адресной строке, расположенной в верхней части Web-броузера, 
следующий адрес: http://www.yahoo.com. На рис. 2.1 показана главная страница 
этого Web-узла на момент написания этой главы. Помните, что методы исполь­
зования и внешний вид большинства Web-узлов время от времени обновляются, 
поэтому сейчас этот узел может выглядеть уже несколько иначе.

Сделайте закладку для Web-страницы Yahoo или внесите ее в список избран­
ных страниц. Сделав это, вы сможете быстро переходить к просмотру каталога 
Yahoo в любой момент, когда захотите начать поиск какой-либо информации.

Поиск по теме

Yahoo имеет иерархическую организацию. Это означает, что можно на­
чать поиск с самой общей темы и постепенно все более и более сужать область 
поиска. Некоторые из основных подтем также перечисляются на одном уровне 
с темами, что дает возможность при желании пропустить один этап.

В Yahoo названия категорий оформлены полужирным шрифтом, а перечни 
тем, которые не подразделяются на категории, набраны обычным шрифтом.
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Рис. 2.1. Главная страница популярного каталога Yahoo
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Давайте представим, что вас заинтересовала одна из проблем врачебной 
этики, например - кому из нескольких кандидатов должен достаться донор­
ский орган для пересадки. В этом случае вы можете начать поиск, выбрав под­
тему Medicine (медицина) категории Health (здоровье), в результате чего на 
экране появится страница Yahoo Health: Medicine (рис. 2.2).

Как видите, одним из подразделов подтемы Health: Medicine является 
Biomedical Ethics (врачебная этика) (Символ указанный рядом с элемен­
том списка, означает, что данная тема встречается в Yahoo в нескольких мес­
тах. Это значит, что вы можете добраться до интересующей вас страницы не 
одним, а несколькими путями, и не должны будете читать мысли других лю­
дей, создавших этот узел). Чтобы перейти к странице, содержащей список стра 
ниц, посвященных нужной вам теме, щелкните на пункте Biomedical Ethics. 
Вы видите, что этот элемент является подразделом иерархии Arts (искусства), 
так как связан с этикой, которая отнесена разработчиками узла к категории ис­
кусств (рис. 2.3).

• ЛюФсЛкяг
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Рис. 2.2. Вы можете попасть на страницу Health>Medicine, либо щелкнув на гиперссылку 
Medicine, либо щелкнув на ссылке Health, а затем выбрав пункт Medicine на странице Health

Помните, что если вам надо вернуться к предыдущей теме в иерархии 
Yahoo, следует воспользоваться кнопкой Back (Назад).

Думаю, что нет необходимости напоминать, что когда вы дойдете до 
страницы, название которой покажется вам интересным, то можете просто 
щелкнуть на соответствующей гиперссылке и перейти сразу к этой странице.
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Поиск по ключевому слову

Конечно, вы понимаете, что не всегда бывает просто угадать, в каком 
именно месте иерархической структуры, подобной Yahoo, следует искать ин­
тересующую вас страницу или тему. На наше счастье, в верхней части каждой 
страницы имеется строка ввода для поиска по ключевому слову. . ■■■

Для того чтобы выполнить поиск, введите ключевое слово (или, чтобы 
сделать поиск более конкретным, несколько слов) в строке, расположенной 
вверху страницы, и щелкните на кнопке Search.

Рис. 2.3. Страница в каталоге Yahoo, посвященная врачебной этике

Если вы выполняете поиск не из главной, а из какой-либо другой страницы, 
то можете выбирать между поиском по всему каталогу Yahoo (Search All in Yahoo) 
и поиском элементов только в текущей категории (Search only in Topic).

Предположим, вам захотелось подробнее узнать о каяках, и вы хотите 
увидеть, имеются ли в Internet какие-либо ресурсы, посвященные этой теме. 
Введите в строке поиска слово kayak (каяк - небольшая лодка, использовав­
шаяся коренными племенами Северной Америки; в настоящее время стала 
спортивным снарядом) и щелкните на кнопке Search, в результате чего Yahoo 
выведет на экран список всех узлов, тем или иным образом связанных с этим 
ключевым словом, как показано на рис. 2.4 (причем само слово на каждой 
странице 6} дет выделено полужирным шрифтом).
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Поиск с помощью поисковых служб

Теперь, когда вам известно, как осуществлять поиск информации в ка­
ком-либо каталоге Web, у вас не вызовет затруднения и использование поис­
ковой службы.

Рис. 2.4. Здесь изображен перечень нескольких страниц, содержащих информацию о 
каяках, полученный я результате поиска в Yahoo

В сущности, единственная разница между первым и вторым средством 
заключается в том, что в первом случае информация, представляемая узлом, 
имеющим, подобно узлу Yahoo, иерархическую структуру, помещается в ка­
талог обслуживающим персоналом. Это означает, что в предоставляемый 
пользователю список входят только узлы Web, которые заслуживают внима­
ния с точки зрения сотрудников каталога. В отличие от такого положения дел, 
большинство поисковых служб стремятся к охвату всех Web-узлов, хотя это 
практически невозможно. (Как уже упоминалось выше, поисковая служба - 
это узел Web, специально предназначенный для выполнения поиска в Internet.) 
Собственно говоря, в обоих случаях вы пытаетесь найти созданный кем-либо 
список узлов, но поисковая служба, как правило, возвращает результаты в бо­
лее широком диапазоне.

Большинство поисковых служб позволяет пользователю делать очень 
специфические, даже сложные, запросы, довольно похожие на те, которые 
предлагаются при работе с программами баз данных. Однако, к счастью, при 
обычном повседневном поиске такой подход не практикуется. Как правило, 
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одного ключевого слова - в крайнем случае, двух (для выполнения более узко­
го поиска) - бывает вполне достаточно. Например, в обсуждаемом нами при­
мере такими ключевыми словами являются слова "медицинская этика".

Теперь надо только начать щелкать на заинтересовавших вас узлах, что­
бы просмотреть содержащуюся на них информацию, так или иначе связанную 
с интересующей вас темой., ,

Программа MS Internet Explorer также имеет встроенную поисковую 
страницу, которая называется Find It Fast (Поиск в Web). Кроме того, при же­
лании можете в качестве используемой по умолчанию страницы поиска назна­
чить ту, которой вы отдаете предпочтение.

Адреса некоторых каталогов и поисковых служб Internet.

Ниже перечислены адреса ряда других интересных каталогов поисковых служб.
Ресурс Web-адрес

Российские
Rambler http://www.rambler.ru
Япбех http://vandex.ru
АУ! http://www.au.ru
Апорт http://www.aport.ru

Зарубежные
Alta Vista http://www.altavista.com
Amazing Environmental Organisation Web 
Directory!

http://www.webdirectorv.com

Berkley Public Library's Index to the
Internet

http://www.ci.berklev.ca.us:80/bpl/
bkmk/index.html

Electric Library h ttp://w w w. el ibrarv. com/id/2525
Yahoo http://www.vahoo.com

3. E-MAIL - ЭЛЕКТРОННАЯ ПОЧТА

Отправка и получение электронной почты

Сейчас рассмотрим основные понятия, связанные с электронной почтой, а 
именно - как отправлять и получать электронные сообщения.

Вы очень скоро привыкнете к применению электронной почты для от­
правки сообщений и поймете, что она является очень удобным средством свя­
зи, не хуже телефона. Кроме того, в отличие от телефонной связи, она не тре­
бует от вашего корреспондента бросать свои дела и немедленно отвечать на 
ваш звонок. Вы можете отправить ему огромное количество информации, а он 
ответит тогда, когда у него будет свободное время. Более того, при этом виде 
связи можно сначала наскоро набросать сообщение, а перед отправкой отре­
дактировать его.

Электронная почта - это "кровь" Internet. Миллионы письменных сообщений 
ежедневно курсируют по проводам, обеспечивая людям на всей планете связь 
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друг с другом в течение считанных секунд. Одной из причин, почему Internet ста­
ла международной компьютерной сетью, является то, что она является достаточно 
гибкой системой и допускает к участию в связи практически любые виды компь­
ютеров. Преимущества такого положения дел очевидны: вы можете отправлять и 
получать сообщения по Internet независимо от того, какой у вас компьютер: 
Macintosh, PC или какая-нибудь экзотическая машина; независимо от того, связы­
ваетесь ли вы с Internet через модем или через локальную сеть; а также независимо 
от того, какой программой электронной почты вы пользуетесь.

Думаю, это маловероятно, что ваша программа настолько специфична, 
что не упоминается мною вовсе. Однако даже в этом случае в первой части 
этой главы вы найдете перечень действий, относительно которых вы можете 
найти информацию в справочной системе своей программы или попросить со­
вета у системного или сетевого администратора вашей организации.

Если у вас имеется учетная запись для удаленного доступа либо если вы под­
ключены к Internet через локальную сеть на работе или в учебном заведении, можете 
работать в любой почтовой программе, которую сможете запустить в привычной 
для вас обычной операционной среде. Если ваш доступ к Internet осуществляется 
через коммерческую сеть, например, через America Online или CompuServe, вам 
следует пользоваться их встроенными программами, и для отправки сообщений по 
Internet потребуется только одно: чтобы вы использовали правильные почтовые ад­
реса Internet Если ваша учетная запись обеспечивает только интерактивный доступ 
к оболочке Unix, вам необходимо управлять своей электронной корреспонденцией 
либо с помощью одной из программ электронной почты Unix (например, Pine), либо 
установить почтовую программу, работающую в автономном режиме (например, 
Eudora), которая будет работать в вашей операционной среде и подключаться к ва­
шей учетной записи только для того, чтобы отправить или получить электронное 
сообщение. И наконец, если вы в основном работаете с электронной почтой в офисе, 
то ваша программа должна носить "групповой" характер - она должна функциони­
ровать как календарь, адресная книга, составитель расписаний и доска электронных 
объявлений. Такая программа также может обеспечить вашу связь по Internet с дру­
гими сотрудниками вашей фирмы.

Работа с электронной почтой

Чаще всего при работе с электронной почтой вы будете выполнять сле­
дующие операции:

• Регистрация почтового ящика;
• Запуск почтовой программы;
• Создание учетной записи:
• Отправка сообщений;
• Чтение входящих сообщений;
• Ответ на поступившие сообщения;
• Удаление сообщений:
• Выход из почтовой программы.
В большинстве случаев регистрация почтового ящика и создание учетной 

записи производится один раз - на сервере провайдера предоставляющего вам 
ycnyi и Internet. Подробнее смотрите ниже.
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Регистрация почтового ящика

Для работы с электронной почтой необходимо завести свой почтовый 
ящик. Эту услугу предоставляют - провайдер, при помощи которого вы под­
ключаетесь к Internet, либо вы регистрируете его на одном из бесплатных поч­
товых серверов.

Рассмотрим регистрацию своего почтового ящика на бесплатном почтовом 
сервере, расположенном по адресу: http://www.mail.ru (рис. 3.1), набрав этот ад­
рес в адресной строке вашего браузера, вы зайдете на главную страницу:

Рис. 3.1. Главная страница бесплатного почтового сервера: http://www.mail.ru.

затем пройдете по ссылке: Получить почтовый электронный адрес имя@тай.ги, 
(в случае, если вы еще там не зарегистрированы) и увидите «соглашение об ис­
пользовании», которое вы должны будете принять.

Теперь предстоит заполнить регистрационную форму, с этим не возникнет 
трудностей, если следовать рекомендациям, приведенным под полями заполне­
ния в регистрационной форме (рис 3.2):

На почтовых серверах регистрируются большое множество пользователей 
и заводят свой идентификатор, так же, как это сделаете и вы, возможно, выбран­
ный вами (Login) уже используется, но не спешите отказываться, добавьте к ва­
шему (Login) ваши инициалы, принадлежность к городу проживания и т.д., на­
пример: ivanov@mail.ru

ivanov_ii@mail.ru
_ivanov_@mail.ru
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Рис 3.2 Регистрационная форма

После успешной регистрации вы увидите сообщение, откуда сможете войти в 
ваш} почту:
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Рис 3.3 Ваша почта.

Запуск почтовой программы

Большинство почтовых программ запускаются точно так же, как любая 
другая программа, то есть, как правило, двойным щелчком на ее пиктограмме 
или с помощью выбора названия этой'программы в меню (в Windows 95 это 
меню Start или Пуск, в Macintosh - Apple). Если соединение с Internet еще не 
установлено, ваша программа электронной почты запустит это процесс.

После того, как почтовая программа запустится, вы увидите на экране 
либо содержимое папки для поступающих в ваш адрес сообщений, либо спи­
сок всех ваших папок (в этом случае вам потребуется открыть окно Inbox или 
Входящие).

В последнее время в Internet появилась новая услуга - бесплатная учетная 
запись для электронной почты (например, Hotmail.com и Juno.com), предла­
гающая доступ к электронной почте, основанной на Web. Все расходы по под­
держанию таких учетных записей оплачивают рекламодатели, размещающие 
свои объявления на Web-страницах соответствующих узлов.

Кроме папки Inbox (Входящие), в которой перечисляются только что по­
лученные сообщения, у вас также имеется папка Outbox (Исходящие), в кото­
рой могут сохраняться копии ваших исходящих сообщений (некоторые про­
граммы делают это автоматически), а также папка Deleted Items (Удаленные) 
или Trash, в которой удаленные сообщения хранятся до тех пор, пока она не 
будет полностью очищена. На рис. 3.6 изображено окно просмотра папки Вхо-
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дящие программы Microsoft Outlook Express.
В списках почтовых папок обычно указываются только имена отправите­

лей и краткое содержание (Subject) сообщений (часто еще дата). Щелкнув 
дважды на сообщении в любой из ваших почтовых папок, вы выведете на эк­
ран окно просмотра самого сообщения.

Рис. 3.4. Здесь изображена папка Входящие в программе Microsoft Outlook Express, в 
которой сообщения перечисляются в порядке их отправления: начиная с самых давних 

и заканчивая последними.

Создание учетной записи/

Для создания учетной записи запустите Microsoft Outlook Express. В ме­
ню «Сервис» выберите «Учетные записи».Выберите закладку «Почта», на­
жмите «Добавить ->Почта». Заполните свои данные: имя, адрес электронной 
почты. Если вы зарегистрировались на сервере http://www.mail.ru, тогда в ка­
честве сервера входящих сообщений напишите: pop.mail.ru а исходящих со­
общений: smtp.mail.ru для остальных серверов эти данные могут быть другими 
или похожими и об их точном заполнении нужно читать в разделе «Вопросы- 
Ответы» на главной странице сервера.

Отправка почты

Все почтовые программы имеют команды New Message (Создать сообще­
ние) или Compose E-mail, которые чаще всего расположены в меню Message 
(Сообщение). Как правило, этим командам назначены клавиатурные эквива­
ленты, например, Ctrl+N - для команды New Message. Когда вы приступаете к 
созданию нового сообщения, программа открывает новое окно. Такое окно, 
открытое в программе Outlook Express, изображено на рис. 3.5.

Большинство программ электронной почты позволяют сохранять адреса и 
впоследствии выбирать их из адресной книги или списка имен вместо того, чтобы 
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вводить их вручную в соответствующей строке окна создания сообщения.
Введите адрес человека, которому хотите отправить сообщение. Этот ад­

рес должен иметь следующий вид: usemame@address.domain, где username - 
это идентификатор пользователя (имя его учетной записи); address - иденти­
фикатор сети и (или) компьютера пользователя в сети (адрес может состоять 
из нескольких слов, обозначающих узел и субдомены, отделенных друг от 
друга точками); a domain - трехбуквенный код, указывающий, является этот 
адрес адресом компании (сот), общественной организацией (org), учебным 
заведением (edu), правительственной организацией (gov), военной организаци­
ей (mil) и т.д. (Для некоторых программ необходимо наличие специального 
текста, расположенного до или после адреса электронной почты Internet).

Рис. 3.5. Окно создания нового сообщения

Кроме того, запомните, что все перечисленные выше категории приме­
няются только при отправке почты по Internet. Как правило, если вы посылаете 
сообщение какому-либо пользователю вашей сети (или другому клиенту ва­
шей диалоговой службы, или другому подписчику вашего провайдера услуг), 
вам надо только указать имя пользователя, не указывая при этом никакой ин­
формации, связанной с Internet.

Самым простым способом отправить кому-либо сообщение является от­
вет на присланное. Если вы не на сто процентов уверены в том, как должен 
быть оформлен адрес чьей-либо электронной почты, просто попросите этого 
человека прислать вам электронное письмо и ответьте на него.

Чтение сообщений

Каждый раз, подключаясь к Internet, необходимо проверять свою элек­
тронную почту. Этот процесс очень похож на то, как вы, возвратившись до­
мой, проверяете свой почтовый ящик, только содержание электронной почты 
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обычно намного интереснее. В некоторых почтовых программах операции от­
правки подготовленных к отсылке сообщений и проверки полученной коррес­
понденции выполняются одновременно. Большинство программ позволяют 
производить проверку содержания почтового ящика при их запуске.

Непрочитанные сообщения (обычно новые), как правило, показаны на эк­
ране с каким-либо указанием того, что они новые: например, тема сообщения 
выделена полужирным шрифтом или рядом с ней стоит флажок либо маркер. 
Эти меры предприняты для того, чтобы вы не пропустили какое-либо сообще­
ние.

Чтобы просмотреть содержание сообщения, выберите его в окне про­
граммы и нажмите клавишу Enter (либо просто дважды щелкните на нем). Вы­
бранное как исходящее сообщение. Окно входящего сообщения в программе 
Microsoft Outlook Express изображено на рис. З.б.

Рис. 3.6. Здесь изображена папка Входящие в программе Microsoft Outlook Express, в 
которой сообщения перечисляются в порядке их отправления: начиная с самых давних 

и заканчивая последними

Если сообщение выходит за пределы окна, воспользуйтесь полосой про­
крутки, чтобы увидеть остальную его часть. Прочитав сообщение, его можно 
закрыть или сразу ответить на него.

Как ответить на электронное сообщение

Где-нибудь рядом с командой New Message (возможно, в том же меню или 
на той же панели кнопок) вы увидите команду Reply (Ответить автору). Чтобы от­
ветить на какое-либо сообщение, выберите его в окне просмотра входящих сооб­
щений, либо откройте его, а затем выберите команду Reply (Ответить автору).
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Если вы начали отвечать на сообщение по ошибке, просто закройте окно 
сообщения и ответьте отрицательно на запрос о его сохранении.

Ваша программа создаст новое сообщение, автоматически адресовав его 
отправителю полученного вами сообщения. Некоторые почтовые программы 
могут также автоматически включать содержание исходного сообщения (или 
предоставляют вам запрос относительно того, следует это сделать или нет). 
Довольно часто, особенно если программа электронной почты была предна­
значена в первую очередь для работы в Internet, включенное сообщение может 
появиться на экране с символом ">" в начале каждой строки. Этот символ ука­
зывает на то, что данный текст является цитируемым, однако в разных про­
граммах применяются разные способы обозначения такого текста. Некоторые, 
например, просто делают перед таким материалом отступ.

Иногда у вас возникает необходимость ответить всем пользователям, ко­
торым было послано полученное вами сообщение. Большинство почтовых 
программ также предлагают вариант команды обычного ответа, при котором 
ваш ответ отправляется всем получателям полученного вами сообщения.

Рис. 3.7. Полученное письмо

Введите тему сообщения и нажмите Tab. (Пользователи часто забывают 
изменять тему, даже если обсуждение зашло уже совершенно в другую об­
ласть). При необходимости добавьте адреса других получателей, либо с помо­
щью клавиши Tab перейдите в область ввода текста сообщения и наберите 
свой ответ. После этого выберите команду Reply (Отправить).

Будьте точны и кратки

Старайтесь сокращать до минимума объем цитируемого текста, который 
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вы включаете в свой ответ. Оставляйте только то, что действительно необхо­
димо для пояснения вашего ответного сообщения (ваш адресат может не пом­
нить, о чем он вам писал два месяца тому назад).

Перепалки - весьма привычное явление в Internet, и вы, несомненно, 
столкнетесь с ними тем или иным образом. Держите себя в руках, когда у вас 
возникает желание кому-либо ответить таким образом.

Удаление сообщений

Если вы прочли какое-либо сообщение и совершенно убеждены, что его 
не надо сохранять, вам следует его удалить, поскольку оно будет только уве­
личивать объем папки входящих сообщений и занимать драгоценное место на 
жестком диске. Чтобы удалить сообщение, обычно следует выбрать его и на­
жать клавишу Del либо щелкнуть на кнопке Delete (Удалить) или Trash, если 
таковые имеются. В большинстве программ это действие переносит данное 
сообщение в папку Deleted mail (Удаленные) или в почтовый ящик Trash, где 
оно хранится до тех пор, пока вы его не удалите окончательно или не завер­
шите сеанс работы в программе.

В некоторых программах нет возможности отменить удаление, поэтому 
прежде чем легкомысленно удалять сообщения, узнайте, как работает ваша 
программа.

Если вы изменили свое мнение относительно удаленного сообщения и 
хотите его восстановить, попытайтесь открыть почтовый ящик Trash или пап­
ку Deleted mail (Удаленные) и найти команду, позволяющую переносить почту 
из одного почтового ящика в другой или из одной папки в другую. Такая ко­
манда может так и называться - Transfer (как, например, в Eudora). Отыскав 
эту команду, перенесите сообщение обратно в папку входящих сообщений.

Выход из почтовой программы

После того, как вы получили почту, прочли ее и отправили ответы, вы 
можете либо выйти из нее, либо оставить ее работать, чтобы она периодически 
проверяла содержание вашего почтового ящика. Из большинства программ 
можно выйти, выбрав команды File>Exit или File>Quit.

Microsoft Exchange, Internet Mail или Outlook Express

Когда появилась Windows 95, программа MS Mail была вытеснена про­
граммой MS Exchange, которая распространялась совместно с новой операци­
онной системой. (Они были похожи друг на друга, но Exchange, наряду с дру­
гими усовершенствованиями, имела больше возможностей, связанных с 
Internet). С выпуском Office 97 Microsoft начала распространение новой, 
улучшенной программы электронной почты - Outlook. Упрощенная и очень 
удобная в использовании версия Outlook, названная Outlook Express, входит в 
комплект поставки новой версии броузера Internet Explorer 4.0 компании 
Microsoft. В отличие от программы Outlook Express, которая предназначена 
только для обработки сообщений электронной почты и групп новостей, 
Outlook - это комплексная программа, позволяющая проводить обсуждения, 
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составлять расписания, сотрудничать с другими пользователями и т.д.
Internet Mail (она часто распространяется вместе с родственной ей про­

граммой Microsoft Internet News или входит в пакет Internet Explorer 3.0) была 
первой программой Microsoft, действительно нацеленной на Internet. При ус­
тановке Internet Explorer 4.0 она заменяется программой Outlook Express. Но­
вейшее программное обеспечение электронной почты Microsoft можно найти 
на следующих Web-узлах компании Microsoft, посвященных Internet Explorer: 

http://www.microsoft.corn/ie или http://www.microsoft.com/ieintl/ru
К счастью, почтовые характеристики Outlook Express сходны с характе­

ристиками Exchange (с некоторыми усовершенствованиями).
Outlook Express может работать с почтой, передаваемой Internet и локаль­

ной сетью. Запустить эту программу можно двойным щелчком на соответст­
вующей пиктограмме на вашем рабочем столе, в результате чего на экране по­
является окно с двумя панелями. На левой панели вы увидите разные элемен­
ты программы, доступные пользователю, и, прежде всего — папку Inbox (Вхо­
дящие) (см. рис. 3.6). На правой панели выводится содержание этой папки (но 
вы можете щелкнуть на большой кнопке Inbox (Входящие), расположенной в 
верхней части списка сообщений, и выбрать другую папку, в результате чего в 
этой панели будет выведено ее содержимое).

Чтобы отправить в Outlook Express сообщение, выберите Compose>New 
Mail Message (Сообщение>Создать) (Ctrl+N), в результате чего на экране поя­
вится окно подготовки нового сообщения. Введите адрес, нажмите Tab и пе­
рейдите в область ввода текста сообщения.

Введите текст сообщения и щелкните на кнопке Send (Отправить). Чтобы 
прочитать сообщение из папки входящих сообщений, надо просто дважды 
щелкнуть на этом сообщении. Ответ на почту отправляется с помощью команды 
Compose> Reply (Сообщение>Ответить автору) (Ctrl+R). В этом случае Outlook 
Express автоматически откроет окно подготовки нового сообщения и укажет в 
качестве адреса получателя адрес автора исходного сообщения. Дальнейшая 
процедура совпадает с операциями при отправке нового сообщения.

Чтобы удалить сообщение, выберите его и щелкните на кнопке Delete 
(Удалить), в результате чего оно будет перемещено в папку Deleted items 
(Удаленные) и будет храниться там до тех пор, пока вы специально не открое­
те эту папку и не удалите содержащуюся в ней почту (при этом вы получите 
предупреждение о том, что данное сообщение удаляется безвозвратно).

Чтобы отменить удаление, откройте папку Deleted Items (Удаленные) и 
выберите сообщение, которое вы хотите восстановить. После этого выберите 
команду Edit>Move То (Правка>Переместить в папку), в результате чего на 
экране появится диалоговое окно, из которого выберите папку Inbox (Входя­
щие) и щелкните на кнопке ОК.

Для выхода из Outlook Express выберите File>Exit (Файл>Выход).
Если вы все еще пользуетесь Internet Explorer 3.0 (или вы начинали с этой 

версии и вас устраивает ее почтовая программа), то можете работать с электрон­
ной почтой в программе MS Internet Mail. При запуске Internet Mail на экране 
появляется окно с двумя панелями. На верхней панели выводится содержимое
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папки Inbox (но вы можете выбрать и другую папку из раскрывающегося спи­
ска, расположенного на панели инструментов), а в верхней - содержание выде­
ленного вами сообщения. На панели инструментов, которую можно при жела­
нии настроить по-своему, вы можете увидеть еще немало полезных команд.

Чтобы отправить почту, выберите Mail>New Message или нажмите Ctrl+N 
в Windows либо Command+N для Macintosh. Введите адрес получателя и два­
жды нажмите Tab. Введите тему сообщения, опять нажмите Tab и введите 
текст сообщения. После этого щелкните на кнопке Send, расположенной в 
верхнем левом углу окна сообщения.

Чтобы проверить в этой программе пришедшую на ваш адрес почту, вы­
берите Mail>Send and Receive или нажмите Ctrl+M (или Command+M). Тема 
непрочитанного сообщения будет выделена в списке полужирным шрифтом. 
Чтобы просмотреть содержание почтового сообщения в нижней панели, выде­
лите его тему в верхней панели (или дважды щелкните на нем, в результате 
чего на экране появится новое окно).

Прочитав сообщение, вы можете выбрать Mail>Reply to Author (или 
Ctrl+R) и ответить на него. Если, начав отвечать, вы передумали, просто за­
кройте окно сообщения, не сохраняя его после соответствующей подсказки.

Чтобы удалить сообщение, щелкните на нем и нажмите клавишу Delete, в 
результате чего оно будет перемещено в папку Deleted Mail. На самом деле это 
сообщение не будет удалено до тех пор, пока вы не удалите его из этой папки.

Если вы хотите ответить всем пользователям, получившим копию полу­
ченного вами сообщения, нажмите не Ctrl+R, а комбинацию клавиш 
Ctrl+Shift+R (или выберите в меню Message>Reply, удерживая при этом кла­
вишу вишу Shift в нажатом состоянии).

Если вы передумали и хотите вернуть удаленное сообщение, откройте 
папку Deleted Mail, выберите в ней нужное сообщение, а затем воспользуйтесь 
командой Mail>Move to>lnbox.

Закончив чтение, отправку и отсылку ответов на почту, вы можете либо 
выйти из программы, либо оставить ее включенной, чтобы иметь возможность 
проверять новые поступления. Для выхода из программы выберите File>Exit.

Новинки программ электронной почты

Конкуренция среди программ электронной почты настолько велика, что 
большинство из них совершенствуется, по меньшей мере, ежегодно и каждое 
новое полезное свойство, появившееся В одной программе, в следующем раун­
де соревнования вернее всего будет улучшено и модернизировано в другой 
программе. Некоторые новые возможности электронной почты, которые в на­
ше время уже становятся стандартом, включают фильтрование (т.е. сортиров­
ку в ходе поступления) почты, получение почты с разных учетных записей, 
управление адресными книгами и добавление форматирования HTML и дру­
гих видов форматирования к электронным сообщениям.

Отправка почты одновременно нескольким получателям

Иногда у вас возникает необходимость отправить сообщение не одному, а 
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нескольким адресатам. Обычно это можно сделать несколькими способами. 
Большинство программ позволяют перечислять адреса нескольких получателей 
в строке То: (Кому), как правило, отделяя их друг от друга с помощью запятой 
(в некоторых применяются другие символы - точка с запятой, например). Мно­
гие программы также имеют строку Сс: (Копия). Аналогично традиционным 
бумажным служебным запискам, в электронных сообщениях эта строка, также 
предназначена для указания пользователей, которым вы хотите отправить ко­
пию сообщения, но которые не являются основными получателями.

Некоторые программы также предлагают строку Вес: (Слепая), с помо­
щью которой вы можете перечислить одного или нескольких людей, которые 
получат так называемые "слепые" копии данного сообщения. Это означает, 
что основной получатель (и получатели, перечисленные в строке Сс: (Копия)) 
не будут знать имен людей, получивших такие копии.

Как правило, вы можете ввести в строке Сс: (Копия) сколько угодно адресов, 
однако некоторые программы "задыхаются" при передаче сообщений со слишком 
длинными заголовками.

Отправка файлов по электронной почте

Согласитесь, это звучит слишком замечательно, чтобы быть правдой. 
Оказывается, можно просто "вложить" файл в электронное сообщение и почта 
мгновенно отправит его адресату на другой конец земного шара. И вам не 
придется сохранять свой файл на дискете и отправлять по простой почте или с 
курьером. Однако дело обстоит несколько сложнее, поскольку некоторые фай­
лы слишком велики для отправки таким способом (если, например, его объем 
около мегабайта). И даже с файлами более подходящих размеров у вас могут 
возникнуть сложности. Большинство проблем возникает по причине несо­
вместимости разных видов компьютеров, типов файлов, а также форматов 
сжатия и кодирования. Попытка заставить все эти элементы работать как сле­
дует несколько напоминает попытку вскрыть замок с шифром.

Одним из наиболее важных свойств электронной почты является то, что 
пользователь может отправлять вместе с сообщением файлы, которые в дан­
ном случае называются вложениями (attachment). Вложение представляет со­
бой файл данных в любой форме, отправляемый вашей программой совместно 
с электронным сообщением.

Во всех программах вложение файлов производится по-разному, а некоторые 
диалоговые службы до сих пор не позволяют отправлять и получать файлы по 
Internet. Кроме того, поскольку разные программы применяют разные способы ко­
дирования (encoding) присоединяемых файлов (т.е. перевода файла в форму, в кото­
рой он может передаваться по Internet), вам может понадобиться связаться с адреса­
том или отправителем таких файлов и сравнить некоторые детали, чтобы удостове­
риться, что ваши программы способны "общаться" в одном и том же коде.

По Internet файлы пересылаются, как правило, в виде простого текста, однако 
существуют протоколы, способные отправлять другие виды информации. Так, на­
пример, некоторые программы используют MIME (Multipurpose Internet Mail 
Extensions - многоцелевое почтовое расширение Internet) для передачи таких ви­
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дов данных, как цветные изображения, звуковые файлы и видеоклипы. Если вы 
получили почту с вложением MIME, вы, возможно, не сможете увидеть картинки, 
услышать музыку или посмотреть фильм, но текстовое вложение должно пройти 
нормально. Вам будет дан запрос, хотите ли вы только просмотреть вложение или 
сохранить его в виде отдельного файла д ля последующего просмотра.

Оставив на время проблемы с самой почтой, хочу напомнить, что иногда 
пользователи пытаются отправить файл, для чтения которого у адресата просто 
нет соответствующего программного обеспечения. Это еще одна деталь, кото­
рую следует проверить и согласовать заранее. Так, например, если вы работаете 
в Word для Macintosh, а ваш получатель - в WordPerfect для DOS, вам необхо­
димо сохранить свой файл в формате, который распознается программой адре­
сата. Вполне вероятно, что для того, чтобы найти такие форматы, вам обоим 
придется внимательно ознакомиться с возможностями, предоставляемыми ко­
мандами Open (Открыть) и Save as (Сохранить как) ваших программ.

Когда вы получаете файл-вложение, ваша почтовая программа, как пра­
вило, декодирует его и сообщает вам, куда он помещен. (Конечно, если ей 
удается распознать формат кодирования. В противном случае в конце сообще­
ния вы увидите не вложение, а набор жутких загогулин. Если это произошло, 
вам придется связаться с отправителем, как я уже говорил ранее.)

Пересылка почты

Если вы получили сообщение и хотите отправить его копию другому 
пользователю, то в большинстве программ это можно сделать с помощью ко­
манды Forward (Переслать).

Эта команда чаще всего располагается рядом с командой Reply (Ответить 
автору) (в том же меню), и работают они почти одинаково. Разница состоит в 
том, что при пересылке полученного сообщения ваша почтовая программа не 
будет вставлять в строку То: (Кому) адрес электронной почты исходного от­
правителя. Эта строка будет пустая, как в новом сообщении. Однако исходное 
сообщение будет автоматически вставлено в новое сообщение, зачастую с оп­
ределенными символами (как, например, стандартный символ Internet для ци­
тируемого текста ">") или с другим оформлением, позволяющим выделить его 
текст в написанном вами сообщении.

Чтобы переслать сообщение, введите в строке То: (Кому) адрес получате­
ля и перейдите с помощью клавиши Tab в область ввода текста сообщения. 
Отредактируйте сообщение и (или) добавьте в его начале свои примечания, 
например, объяснение причин, по которым вы его пересылаете. После этого 
отправьте сообщение как обычно.

Фильтрование сообщений в ходе их поступления

В основе применения фильтров лежит их способность распознавать тип вхо­
дящей почты, как правило, по одному из заголовков сообщения (например, от ко­
го это сообщение; кому или по какому списку почтовой рассылки оно было от­
правлено, или по его теме) и автоматически переносить его из папки Inbox (Вхо­
дящие) в соответствующую папку (или почтовый ящик, в зависимости оттого, как 
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это называется в вашей программе). Наилучшие в техническом отношении фильт­
ры могут автоматически отправлять ответы на сообщения, переправлять почту 
другому получателю, выполнять множественные действия и так далее.

Установка и настройка фильтров займет у вас совсем немного времени, 
особенно если сравнить его с тем огромным объемом рутинной работы, ко­
торую вам придется переделать в будущем, не имея .их. Поверьте, как только 
вы поставите фильтры, которые начнут управлять вашей почтой, то не пере­
станете удивляться, как вы могли раньше обходиться без них (а может, про­
сто воспрянете духом и подпишитесь на двадцать новых списков почтовой 
рассылки!).

Работа с почтой нескольких учетных записей

Возможно, в какой-то момент вы поймете, что имеете более одной 
учетной записи электронной почты. Это может произойти намного проще, 
чем кажется. Например, после длительных раздумий вы подключаетесь к 
провайдеру Internet из дома за свой счет, а после этого ваш шеф неожиданно 
пересматривает свое отношение к Internet и вам открывают доступ к Internet 
на работе (или наоборот) - и, пожалуйста! Теперь вам придется управлять 
несколькими учетными записями сразу. Как же в этом случае организовы­
вать работу?

Существует ряд подходов к решению этой задачи. Первый заключается в 
том, что все учетные записи электронной почты функционируют абсолютно 
раздельно. Этот подход идеален для полного разграничения личной жизни и 
работы, то есть для того, чтобы у вас был официальный рабочий адрес и канал 
личной связи с друзьями и для непредвиденных ситуаций.

С другой стороны, некоторые люди регистрируют личные учетные записи 
исключительно для того, чтобы получить доступ к уже существующей учет­
ной записи на работе. В этом случае никакой необходимости хранить почту в 
разных местах нет. При этом, однако, возникает проблема, как объединить всю 
свою почту и быть уверенным, что ничего не пропущено. (Существует еще 
одна связанная с этим проблема - как просматривать свою почту, находясь 
дома, не удаляя ее при этом из основной рабочей области).

Известны два способа объединения почты нескольких учетных записей. 
Один из них заключается в настройке вспомогательной учетной записи (или 
всех учетных записей, кроме одной, основной) на автоматическую пересылку 
сообщений на ваш основной адрес. Однако это не всегда возможно, и даже ес­
ли возможно, методы добиться этого в разных системах разные, поэтому сле­
дует связаться со своим системным администратором и расспросить его об 
"автоматической пересылке почты".

Более простой способ заключается в том, что некоторые почтовые про­
граммы могут быть настроены на проверку множественных адресов (или про­
веряют некоторые адреса автоматически, а некоторые - когда вы делаете соот­
ветствующий запрос). Если вам приходится иметь дело с несколькими учет­
ными записями и вы предпочитаете объединить всю свою почту, я бы посове­
товал вам достать программу, предлагающую такие возможности (например, 
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Outlook Express или любую другую программу семейства Microsoft).
Управление адресной книгой

Если вы постоянно обмениваетесь с кем-либо корреспонденцией по элек­
тронной почте, либо вам приходится связываться с людьми, адреса которых 
плохо запоминаются или их трудно вводить, не сделав при этом ошибки, то 
знайте, что большинство программ позволяют создавать для таких адресов 
псевдонимы (aliases). Эти псевдонимы представляют собой короткие слова, 
которые вводятся вместо настоящего адреса. Списки таких адресов обычно 
группируются в так называемые адресные книги. Эти книги создаются по 
принципу обычных адресных книг, и их модули и окна часто включают место 
для другой важной информации (например, сведений об обычном почтовом 
адресе, либо номере телефона и факса).

В некоторых программах электронной почты и программах для коллектив­
ного использования данных адресная книга применяется совместно с другими 
приложениями, установленными на вашем компьютере, благодаря чему кон­
тактная информация будет доступна из разных программ. Когда вы вводите 
псевдоним или выбираете из адресной книги имя, программа электронной поч­
ты автоматически вставляет правильный адрес в строку То: (Кому) вашего со­
общения (некоторые программы также вставляют адрес в строку Сс: (Копия)).

Кроме того, вы можете назначить псевдоним для списка адресов и рассы­
лать почту одновременно группе людей.

Назначая псевдоним для адреса электронной почты или создавая элемент ввода 
адресной книги, делайте их как можно короче, ведь основная их цель - именно изба­
вить вас от введения объемных данных. Старайтесь также, чтобы они были легко за­
поминаемыми (хотя их можно в любой момент просмотреть, если вы их забудете).

Просто скажи: "Пришли мне сообщение"

Если вы не уверены, как посылать почту какому-либо пользователю, но 
точно знаете, что он подключен к Internet, просто попросите его прислать вам 
сообщение. Если оно пройдет нормально, вы будете иметь правильный обрат­
ный адрес. Вам следует скопировать либо сохранить этот адрес, создать для 
него псевдоним или просто оставить это сообщение и ответить на него, когда 
вы захотите отправить этому пользователю письмо (постарайтесь не забыть 
изменить тему в соответствующей строке).

Действительно, самым лучшим способом получения адреса является по­
лучение его непосредственно от его владельца. В последнее время многие 
включают свой электронный адрес в визитную карточку, и это тоже неплохой 
способ заполучить правильный адрес

Отправьте почту в адрес postmaster@

Если вы хотите связаться с человеком и вам известен только его домен 
(например, вы знаете, в какой компании он работает, или что он является кли­
ентом одной из диалоговых служб), вы можете попытаться отправить свое со­
общение по адресу.

postmaster@anpec_opraHH3auHH
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и сделать вежливый запрос относительно интересующего вас электронного адре­
са. Согласно стандартам Internet требуется, чтобы каждая сеть выделяла адрес 
postmaster@aflpec_opraHH3aUHH реальному человеку, который отвечал бы на во­
просы и претензии. Таким образом, если вам, например, надо найти кого-либо, кто 
является пользователем Pipeline, вы можете отправить сообщение на 
postmaster@pipeline.com с запросом относительно адреса интересующего вас человека.

Работа с MS Exchange, Internet Mail или Outlook Express

Если вам необходимо переслать сообщение с применением программы 
MS Outlook Express (или Exchange), щелкните на кнопке Forward (Переслать), 
выберите команду Compose>Forward (Сообщение» Переслать) или нажмите 
Ctrl+F, а затем выполните операции, как при создании нового сообщения. Что­
бы отправить почту нескольким адресатам, введите их адреса в поле То: (Ко­
му), - отделяя их друг от друга не запятыми, а точками с запятыми - или вве­
дите дополнительные адреса в строке Сс: (Копия).

Если у вас установлена программа Microsoft Word и вы хотели бы поль­
зоваться ею для создания сообщений в Outlook, выберите команду 
Tools>Options (Сервис>Параметры), щелкните на вкладке E-Mail (Электронная 
почта), установите флажок Use Microsoft Word as E-Mail editor (Использовать 
Microsoft Word как редактор сообщений) и щелкните на кнопке ОК. (В Outlook 
Express данная возможность отсутствует.)

Чтобы создать новую папку для сообщений в программе Outlook, первым 
делом нажмите клавишу Backspace, в результате чего на экране появится окно 
Personal folders (Личные папки). После этого выберите команду 
File>New>Folder (Файл>Создать>Папка) или нажмите комбинацию клавиш 
Ctrl+Shift+Е. В появившемся диалоговом окне New folder (Новая папка) ука­
жите имя новой папки и щелкните на кнопке ОК. Чтобы переместить сообще­
ние в новую папку, надо щелкнуть на нужном сообщении и перетянуть его в 
эту папку (т.е. в левую панель).

Чтобы создать новую папку в Internet Mail или Outlook Express, выберите 
команду File>Folder>Create (Файл>Папка>Создать папку), в результате чего на 
экране появится диалоговое окно Create New Folder (Создать папку). Введите в 
него имя новой папки и щелкните на кнопке ОК. Для перемещения сообщения 
в папку, щелкните на нем и выберите команду Mail>Move То>имя_папки 
(Правка>Переместить в папку).

Программа Internet Mail предлагает пользователям наипростейший тип 
фильтрования сообщений: почта с заранее указанным текстом в одной из 
строк, описывающих получателей сообщения, отправителя или тему, может 
автоматически отправляться в указанную папку. В программе Outlook Express 
средства сортировки были значительно доработаны - в ней можно анализиро­
вать не только строки адресов и тем, но и учетные записи, а также выполнять 
различные операции над сообщениями, такие как перемещение или копирова­
ние в другую папку, пересылка заданному адресату, автоматическая отправка 
стандартного ответа и т.д. В программе Outlook 97 средства сортировки сооб­
щений отсутствх ют. Чтобы настроить фильтр, или правила, выберите команду 
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Maii>lnbox Assistant (Сервис>Сортировщик сообщений) и щелкните на кнопке 
Add (Добавить), в результате чего на экране появится диалоговое окно 
Properties (Свойства). Чтобы иметь возможность в программе Internet Mail от­
бирать сообщения с текстом, введенным вами в соответствующий заголовок 
(заголовки), укажите соответствующий текст в одной или более строках ввода, 
расположенных в верхней части этого окна. После этого в раскрывающемся 
списке Move То выберите папку, в которую будет переноситься почта. В про­
грамме Outlook Express можно выполнить и ряд других действий (рис.3.8).

Созданный фильтр добавляется к списку в диалоговом окне Inbox Assistant 
(Сортировщик сообщений) в виде фразы, близкой к разговорному языку, например, 
Перенести в "Похоже на рекламное письмо", если Тема содержит слово "Деньги". 
При желании можете добавить и другие фильтры. Выполнив описанные операции, 
щелкните на ОК. Программу Outlook можно настроить для проверки новой почты, 
полученной из нескольких служб разного типа (чтобы увидеть варианты, выберите 
команду Tools>Services (Сервис>Службы)), но вы не сможете настроить эту про­
грамму для проверки почты, полученной, например, на две разных учетных записи 
электронной почты Internet. Программа Internet Mail также не обладает такими воз­
можностями. Если у вас возникла острая необходимость в работе с несколькими 
учетными записями, советую воспользоваться программой Outlook Express (команда 
Сервис» Учетные записи).

Рис. 3.8. Самыми широкими возможностями по сортировке входящей почты обладает 
программа Outlook Express

Для присоединения файла в Outlook Express или Internet Mail надо либо 
открыть окно, в котором находится этот файл, щелкнуть на нем и перетащить 
в окно нового сообщения, либо, находясь в этом окне, выбрать команду 
lnsert>File (Вставка>Вложение файла) и выбрать в появившемся в результате 
этой операции диалоговом окне Insert File (Вставка вложений) нужный вам 
файл. После этого щелкните на кнопке ОК. На рис. 3.9 показано сообщение
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Outlook Express с файлом-вложением.
Чтобы занести нового адресата в свою адресную книгу, выберите коман­

ду Tools >Address Book (Сервис>Адресная книга) или нажмите комбинацию 
клавиш Ctrl+Shift+B. В открывшемся окне воспользуйтесь командой File>New 
Entry (Файл>Создать адрес), в результате чего на экране появится диалоговое 
окно New Entry (Свойства): Введите имя, нажмите клавишу Tab и в соответст­
вующей строке введите адрес электронной почты. Щелкните на -кнопке Add 
(Добавить), а затем на кнопке ОК. Для отправки корреспонденции пользовате­
лю, чей адрес включен в вашу адресную книгу, начните новое сообщение 
обычным способом, но вместо адреса получателя щелкните на пиктограмме с 
изображением листика из блокнота, расположенной слева от строки То: (Ко­
му:). Выберите адресата из списка в появившемся диалоговом окне, щелкните 
на кнопке То -> (Кому->) и щелкните на кнопке ОК.

Рис. 3.9 Вложенный файл отображается в окне подготовки сообщения Outlook Express 
в виде пиктограммы. Получателю сообщения достаточно будет щелкнуть на этой пик­
тограмме. чтобы открыть вложенный файл с помощью соответствующего приложения

Чтобы проверить правописание сообщения, выберите команду Tools>- 
Spelling (СервиОПравописание) или нажмите клавишу F7. Запустится про­
грамма проверки правописания, которая начнет проверять текст и искать неиз­
вестные ей слова.

Если вы когда-либо пользовались средством проверки правописания в 
Word или любом другом стандартном текстовом редакторе, вам должны был ь 
знакомы следующие приемы.
• Чтобы пропустить слово, щелкните на кнопке Ignore (Пропустить).
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• Чтобы изменить слово на предложенный вариант, щелкните на Change (Заменить).
• Чтобы вручную исправить обнаруженное слово с ошибкой, внесите изменения в 
строке Change То: (Заменить на:) и щелкните на кнопке Change (Заменить).
• Чтобы добавить слово к словарю средства проверки правописания, щелкните 
на кнопке Add (Добавить).

В Internet Mail для проверки правописания выберите команду Mail > 
Check Spelling или нажмите клавишу F7.

Outlook позволяет производить форматирование текста, за исключением 
форматирования в стандарте HTML. В этой программе даже имеются шаблоны 
(чтобы увидеть примеры, выберите команду Compose>Choose Template (Сообще- 
ние> Выбрать шаблон)) с предопределенными элементами форматирования. 
Internet Mail и Outlook Express предлагают форматирование HTML. Чтобы офор­
мить электронное сообщение с применением такого форматирования, выберите 
команду Format>HTML (Формат>НТМЕ), в результате чего в верхней части ваше­
го сообщения появится новая панель инструментов форматирования. С помощью 
кнопок на этой панели вы можете отформатировать свое сообщение (сделать текст 
или его элементы полужирным, оформить' курсивом, ввести маркированные спи­
ски, ввести выравнивание текста и изменить его пвет).

Для создания подписи в Outlook выберите команду Tools>Autosignature 
(Сервис>Автоподпись) и на экране появится диалоговое окно Autosignature 
(Автоподпись). Введите свою подпись и установите флажок Add this signature 
to the end of new messages (Добавлять эту подпись в конце новых сообщений). 
После этого становится доступным флажок в нижней части окна, с помощью 
которого можно запретить добавление подписи к пересылаемым сообщениям 
и сообщениям, являющимися ответами. Щелкните на кнопке ОК. В программе 
Internet Mail для создания подписи выберите команду Mail>Options и щелкни­
те на вкладке Signature диалогового окна Options. Для того чтобы ввести под­
пись непосредственно, щелкните на переключателе Text; чтобы ввести путь и 
имя уже существующего файла подписи, выберите переключатель File. (В 
программе Outlook Express для открытия аналогичного окна Подпись необхо­
димо воспользоваться командой Сервис>Бланк сообщений, а затем щелкнуть в 
открывшемся окне Бланк на кнопке Подпись.)

4. Передача файлов с помощью FTP

Протокол FTP

Конечно, можно отправить файл в виде вложения к своему электронному со­
общению, но если файл очень большой, этот способ неэффективен и требует мно­
го ресурсов. В качестве альтернативы можно воспользоваться FTP - методом, по­
зволяющим извлекать файлы из других компьютеров в Internet и отправлять их на 
другие компьютеры.

В идеале FTP когда-нибудь должен быть встроен в операционную систему 
Macintosh или Windows (как уже встроен в Unix), что позволит сделать управле­
ние файлами в Internet таким же простым и легким, как управление ими в вашем 
компьютере. На сегодняшний день, однако, нам приходится пользоваться FTP с 
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помощью специальных программ либо Web-броузеров.
Возможно, вам также приходилось слышать об анонимных FTP. В большинст­

ве случаев, выполняя пересылку файлов по FTP, вы делаете это анонимно, подклю­
чаясь к общедоступным узлам FTP. Это означает, что вы входите в систему как 
пользователь с именем anonymous и даете в качестве пароля свой адрес электронной 
почты. Если вы пользуетесь FTP для обмена файлами: с компьютером, к которому 
вы имеете санкционированный доступ, то в этом случае войдете в систему, указав 
свое имя и пароль, выданные вам администратором соответствующего узла.

Что нового в FTP

Всего за несколько лет протокол FTP прошел путь от чисто технического 
протокола, для понимания которого надо было тщательно изучить Unix, до метода 
обмена файлами, которым так же просто управлять, как Web-броузером. Сле­
дующим шагом в эволюции FTP будет его непосредственное включение в про­
граммы и компьютерные операционные системы. Уже сегодня программы типа 
Microsoft Office 97 обладают возможностью открывать файлы из узлов FTP и со­
хранять их в узлах FTP. Разработчики броузеров обещают добавить в следующие 
версии своих продуктов встроенные средства поддержки протокола FTP, превра­
тив, таким образом, связь по протоколу FTP в стандартную операцию, выполняе­
мую непосредственно на рабочем столе. Кроме того, существует очень большая 
вероятность, что в результате следующей значительной модификации Windows и 
MacOS они будут включать возможности FTP по переносу файлов непосредст­
венно в интерфейс. Вернее всего, этот процесс будет практически неотличим от 
перемещения файлов из одной папки в другую или с жесткого диска на диск ZIP.

Облегчается также и процесс нахождения узлов FTP в Internet. Поскольку ар­
хивы FTP не являются частью Web в буквальном смысле слова (хотя вы действи­
тельно можете подключиться к узлу FTP с помощью Web-броузера), до последнего 
времени их не всегда можно было найти с помощью поисковых служб Web. Един­
ственным способом отыскивать узлы и файлы была система Archie. Совсем недавно 
появились специальные узлы Web, обеспечивающие возможность находить узлы 
FTP по именам файлов. Я расскажу об этом подробно в следующем разделе.

Как находить узлы FTP

Если вы ищете файлы, чтобы переписать их на свой компьютер из узлов 
FTP, попробуйте обратиться к одному из следующих узлов Web.

• Shareware.com
• Download.com
• Filez.com
• Hotfiles.com

Список 100 крупнейших российских ftp-серверов можно найти на сервере 
http://download.virus.ru/ в разделе Russian FTP по гиперссылке

«Список ста крупнейших российских FTP-серверов».
Можно осуществлять поиск файлов и старыми методами. Скажем, вы ка­

кое-то время читаете сообщения группы новостей Usenet, и у вас возникает 
вопрос, имеется ли где-нибудь архив старых статей, которых вы никогда не 
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видели. Вы публикуете этот воцрос в группе и вам присылают по электронной 
почте ответ, что действительно, такой архив существует и доступен через ано­
нимный FTP по адресу archive.big-u.edu. Вы сохраняете адрес в текстовом 
файле, а после этого проверяете указанный узел FTP с помощью своей про­
граммы FTP. Это один из способов разузнать об интересующих вас узлах.

Существует также FAQ для анонимных пользователей FTP и огромный, 
организованный в алфавитном порядке комплект списков узлов FTP (всего та­
ких списков одиннадцать), который регулярно публикуется в группах ново­
стей answers, news, newusers, questions и во многих других группах Usenet.

Чаще всего вы будете находить и обращаться к узлам FTP через свой Web- 
броузер. Поскольку для этого вам придется только щелкать на гиперссылках, то, 
подключившись к узлу FTP, вы можете даже не понять, что уже сделали это.

Многие из очень крупных и самых известных архивов имеют так назы­
ваемые "зеркальные" узлы (mirror site), представляющие собой другие узлы 
FTP, в которых хранятся те же файлы, обновляющиеся синхронно с файлами 
основного узла. Это позволяет снизить нагрузку на основной узел. По возмож­
ности пользуйтесь зеркальными узлами.

Общие принципы передачи файлов

Обычно сеанс работы по протоколу FTP начинается с запуска соответст­
вующей программы и подключения к узлу FTP. В зависимости от того, какой 
программой вы пользуетесь, вы либо вводите свою информацию для входа в 
систему перед подключением; либо вам дается подсказка сделать это уже по­
сле того, как произошло подключение. Если вы подключаетесь к анонимному 
узлу с помощью Web-броузера, вам не потребуется вводить пользовательское 
имя и пароль. Наберите слово anonymous и нажмите клавишу Enter, после это­
го наберите свой адрес электронной почты и опять нажмите Enter. Если все 
было сделано правильно, вы увидите командную строку FTP.

Наиболее известные узлы, такие как RTFM в MIT, часто очень загруже­
ны. Чтобы свести к минимуму нагрузку на узел FTP и сэкономить свое время, 
лучше всего выполнять переписывание файлов не в пиковое время, например, 
ночью или в выходные.

Если у вас имеется доступ к узлу FTP под собственным именем, то при 
анонимном входе на этот узел FTP никогда не вводите реальный пароль. Это 
может привести к нарушению безопасности, поскольку пароль появится во 
входном файле, который смогут прочесть многие люди. Если же вы сделали 
это по ошибке, немедленно смените пароль.

Теперь просмотрите списки файлов и найдите в структуре каталогов нужные 
вам файлы. Вы могли подключиться к машине Unix, либо к какому-либо другому 
типу компьютера в Internet. К счастью, вам не придется заучивать все многочис­
ленные команды, которые нужны для разных типов машин. Достаточно знать ко­
манды вашей программы FTP, а она сама будет интерпретировать ваши запросы в 
любой формат, необходимый для данного узлового компьютера.

Если вы не знаете точно, где начать искать узел FTP, начните с поиска в 
каталоге pub. Найдя его, пройдите по его подкаталогам. Если файлы, которые 
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вы намерен^: ереписывать с компьютера на компьютер, не являются тексто­
выми файлами (например, если это программы), перед копированием укажите, 
что они имеют бинарный формат- введите команду binary. Найдя нужный 
файл, перенесите его, пользуясь для этого командой get (или, если переносится 
одновременно несколько файлов - командой mgfet). Теперь выйдите из про­
граммы FTP - вы сделали то, что хотели.

Перенос файлов по электронной почте, в случае, если у вас нет "на­
стоящего" FTP

Если у вас нет "настоящего" FTP, вы можете получить доступ к одному из 
почтовых серверов в Internet, который будет за вас обращаться к серверу FTP и 
присылать полученные в результате файлы. (Это немного похоже на то, как 
мы просим кого-либо выписать для нас книгу в библиотеке и прислать нам ее 
по почте). Этот метод получения файлов менее эффективен, чем использова­
ние полноценной программы связи по FTP

Получение файлов с применением Web-броузера

Вы уже читали о том, как загружаются файлы из узлов FTP с помощью 
Web-броузеров (как правило, для этого надо только щелкать на гиперссылках). 
Если вы хотите выйти прямо на узел FTP, то можете ввести его адрес в адрес­
ной строке броузера, начав его с ftp: //, например, 

ftp://rtfm.mit.edu/pub/usenet-by-group.
При работе с более старыми версиями броузеров можно подключиться 

только анонимно и, кроме того, вы сможете лишь получать файлы, но не от­
правлять их. Однако большинство новых броузеров позволяют подключаться с 
применением пользовательского имени: для этого перед адресом FTP ставится 
имя пользователя и символ "@".
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